
Chapter 2: Window Explorer
1.Starting Windows Explorer ..................................................................................................WD-1

2.The Windows Explorer Window ..........................................................................................WD-1

3.Changing the Current Folder I Displaying Contents of a Folder .........................................WD-2

4.Opening and Closing a Folder .............................................................................................WD-2

5.Creating a New Folder .........................................................................................................WD-3

6.Selecting a File or Folder .....................................................................................................WD-3

7.Viewing Icons in the Contents Area ....................................................................................WD-3

8.Selecting Multiple Names (Files and/or Folders) ................................................................WD-4

9.Copying a File (and/or Folder) ............................................................................................WD-4

10.Moving a File (and/or Folder) ...........................................................................................WD-5

11.Deleting a File/Folder ........................................................................................................WD-5

12.Renaming a File or Folder .................................................................................................WD-6

Revision Exercises .......................................................................................................................WD-7
Practical Exercises .......................................................................................................................WD-7





CHAPTER 2: WINDOWS EXPLORER

Windows Explorer is an application program included with Windows that allows the user to view 
the contents of the disk drives, the hierarchy of folders on the computer, and the files and folders in 
each folder. It also allows you to organize the files and folders on the computer by copying, moving 
and deleting the files and folders. You are also allowed to create a folder, rename a file or folder, 
and even open a file by using Explorer. 

A file is a collection of data or information that is treated as a unit by the computer (Williams & 
Sawyer 2005). To facilitate users, the files are electronically organized in groups called folders. A 
folder is a collection of files and other folders (subfolders). 

1. Starting Windows Explorer 

Among the many ways to open the Windows Explorer window are: 
1. Right-click the Start button or My Computer icon, and choose Explore. 

2. Press  + E keys.
3. Click Start, choose Run, and type explorer in the dialog box. 
4. Choose Windows Explorer from the Start menu.
5. Double click any of the standard icons and click Folder on the toolbar. 

2. The Windows Explorer Window 

The  icon  on  the  title  bar  in  Figure  2.1  identifies  the 
window as Window Explorer window. The title, in this 
case My Computer, indicates that probably you opened 
the window using the My Computer icon. The Explorer 
window  has  a  menu  bar,  toolbar(s),  address  bar  and 
status bar. The address bar shows the current folder. 

The  window  area  is  divided  into  two  main  areas 
separated by a vertical bar, as shown in Figure 2.1. The 
left side or panel, identified by the Folders title, contains 
a  hierarchy  of  folders  on the computer.  The right  side 
shows the contents of the current folder. 

Figure 2.1

The  Folders  area shows a graphic representation of the 
organization of the major parts of your computer.  This 

representation of organization is called a hierarchy or tree. Subfolders are folders listed below its 
main folder name in an indented manner. Files can be stored in a drive, a folder or a subfolder. 
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The  in front of a folder name indicates that all of its subfolders are displayed in the hierarchy. 
Clicking  the  minus  sign  will  collapse  the  folder,  removing  the  indented  subfolders  from the 
hierarchy of folders. The minus sign changes to a plus sign. 

A plus sign  to the left of a folder name indicates the folder consists of one or more subfolders 
that  are  not  visible  in  the  tree.  Clicking  the  plus  sign  will  expand  the  folder,  displaying  its 
subfolders and changes to a minus sign. 

If  no plus or minus sign is in front of a folder,  the folder does not contain any subfolder.  For 
example, the My Music folder in Figure 2.1 has no subfolder since no plus or minus sign precedes 
its icon. 

The  Contents area  displays the contents of the selected item in the Folders area. It displays the 
subfolders and/or files in the selected item. Always check the address bar to see if you are at the 
correct folder. The status bar displays the number of objects and items shown in the Contents area 
and the current folder name. 

3. Changing the Current Folder I Displaying Contents of a Folder 

Changing current folder is necessary when you want to work with the contents of a folder, either to 
move, copy or delete a file or files. Changing the current folder is the same as opening a folder. 
Check the address bar or status bar to see if you have changed to the correct folder. 

4. Opening and Closing a Folder 

Opening a folder in order to see its contents can be done in some ways. 
1. Click the folder (at its name icon) in the Folders area. You may have to collapse or expand a 

folder before clicking. 
2. Double-click the folder in the Contents area.
3. Change the address in the address bar. 

When you open a folder, the folder icon will be shown as an open folder  in the Folders pane. 
Opening a folder will automatically closes the previous opened folder. 
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5. Creating a New Folder 

Figure 2.2
Before you create a folder, make sure the current folder is where you want the folder to be. It can be 
at a drive or another folder. If not, change to the desired folder. 

Some of the ways to create a folder are as follows. 
1. File/New/Folder. 
2. Point to any blank area in the Contents area, right-click (to get shortcut menu). Then select 

New, and choose Folder (Figure 2.2). 

A new folder icon is displayed with the name shown in a text box as . This means 
that you can rename the folder if you wish. (Refer to Rename a File or Folder topic). Press Enter 
key or click anywhere in the window to confirm the name given. 

6. Selecting a File or Folder 

A file is shown only in the Contents area and identified by its name. To select a file: 
1. Check the current folder -must be where the file is. If not, change it. 
2. Click at the file name or its icon at the Contents area. The name will be highlighted (in a 

colored box). 
Note: Selecting a folder is the same as selecting a file. 

7. Viewing Icons in the Contents Area 

You can view the icons in the Contents area in many different ways to suit your need. The List view 
lists all the content of the selected folder preceded by small icons, allowing you to easily see many 
of the contents of a folder. The Details view also lists the contents preceded by small icons, together 
with detailed information about the item. The Icons and Tiles view displays the contents preceded 
by larger  icons,  by which you can see basic  information of  every item in the  Tiles  view.  The 
Thumbnails  and  Filmstrip  view displays the miniature version of picture files contained in the 
open folder. 
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You can see the view type provided by your Windows Explorer and choose one that you need from: 
1. The View pull-down menu 
2. The shortcut menu when you right-click in the Contents area. 

8. Selecting Multiple Names (Files and/or Folders) 

If the names are contiguous, i.e. the names are listed next to each other: 
1. Click the first name you want to select. 
2. Hold down the Shift key and click the last name that you want to select. All items in 

between, including the first and last name, are highlighted. 

If the names are noncontiguous, i.e. the names are separated by other names you do not want: 
1. Click the first name you want to select. 
2. Holding down the Ctrl key, click each of the names you want to select. 

9. Copying a File (and/or Folder) 

When copying a file, you must know several details/information: 
a) Where is the source drive and/or source folder (from where)?
b) What is the filename? 
c) Where is the destination (to where)? 

You can copy from one location to the same location, but the new file will be given a new name. A 
file can also be copied from one location to another location (different drive or different folder of 
the same drive), and the new file will have the same name as the source file. Make sure both the 
source and destination folders are shown on the left side. If not, you may have to expand certain 
folder or drive. 

Below are five ways to copy a file from the source folder to the destination folder.
1. Dragging the selected filename from the right area to left panel. While dragging, the icon 

and its name are dimmed. At the left side, drag the filename with the pointer beside the 
destination folder so that it is highlighted. Release 'the left mouse button. 
Note:  When dragging a file from one drive to another folder in the  same drive,  Explorer 
automatically assumes that you will be moving the file. You have to hold down the Ctrl key 
to change the pointer shape to indicate copying. 

2. Using the Edit menu: select the file (from where and which file); choose Edit then Copy; 
select the destination location (in the left side); choose Edit then Paste 

3. Using the Copy and Paste buttons on the toolbar; similar to the Edit menu.
4. Using the shortcut menu (by right-clicking at the filename) --Copy and Paste. 
5. Right  drag the filename from the right area to the destination folder  (in the left  panel); 

release mouse button; and choose Copy from the shortcut menu. 

Note:  A Copying... dialog box will appear to show what and from where to where the copying is 
done. You may get a Confirm File Replace dialog box asking if you want to change the contents of 
file  in  the  destination  to  the  contents  of  the  source-only  if  the  filename  already exists  at  the 
destination. You may copy several files only from one location to a different location. 
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10. Moving a File (and/or Folder) 

Similar to copying a file, you need to know the source location (drive and/or folder), source file, 
and the destination location. You can move from one location to a different drive or different folder 
of a drive; the new file will have the same name as the source file. Make sure both the source and 
destination folders are shown on the left side. If not, you may have to expand certain folder or drive. 

Below are 5 ways to move a file from the source folder to the destination folder. 
1. Dragging the selected filename from the right area to the destination folder in the left panel; 

then release the left mouse button. 
Note: When dragging a file from one drive to another folder in another drive,  Explorer 
automatically assumes that you will be copying the file. You have to hold down the Shift 
key to change the pointer shape to indicate moving. 

2. Using the Edit menu: select the file (from where and which file); choose Edit then Cut; 
select the destination location (in the left side); choose Edit then Paste 

3. Using the Cut and Paste buttons on the toolbar; similar to the Edit menu. 
4. Using the shortcut menu. 
5. Right drag as in copying a file, but choose Move in the shortcut menu. 

Note:  A Moving... dialog box will appear to show what and from where to where the copying is 
done. 
Caution: Before copying or moving a file, make sure that no file of the same name as the source file 
exists at the destination. If one exists and you answered yes in the Confirm File Replace dialog box, 
you will change the contents of the file already existing in the destination. Therefore, its original 
content will be lost. 

11. Deleting a File/Folder 

When you delete a file or folder from the hard disk, e.g. drive C, the computer will throw it away 
into the Recycle Bin. The item may be restored (put back at its original location). However, if you 
delete an item from a removable disk like the diskette (drive A) or USB disk, the item will be 
permanently deleted (It is not put into the Recycle Bin and cannot be restored). Deleting a folder 
will delete all of its contents. 

Five ways to delete a file/folder are listed below: 
1. Dragging the selected file to the Recycle Bin (on the desktop or in the Folders pane of the 

Explorer window. 
2. Choose File menu then Delete command. 
3. Using the Delete button on the toolbar. 
4. Using the shortcut menu, Delete. 
5. Right-drag instead of dragging. 
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Note: A Confirm Delete dialog box will appear indicating what will be deleted and asking you to 
confirm the deletion. 
To permanently delete an item from the hard disk, press Shift while deleting it. 

12. Renaming a File or Folder 

You can change the name of a file or folder whenever you see a text box appear at its name. There 
are four ways to rename. 

1. Click twice at the name. 
2. File/Rename. 
3. Use shortcut menu, choose Rename. 
4. Click at the name, press F2. 

If the name is highlighted in the text box, typing a new character will automatically delete the name 
in the box (to replace with a new name). To edit the name, press an arrow key to move cursor or 
insertion point to the location to type, and then type the new character. Press Enter key when done 
renaming. 

A file has a  filename.  Windows and Windows-based programs allow you to use long folder and 
filenames (up to 255 characters). The possible characters in a filename are: 
letters A to Z 
digits 0 to 9
and special characters: usually the _ (underscore) 
Spaces are allowed in names, but the following characters are NOT allowed: \ / : *?"<>I 

A file may have a file extension, usually to indicate the type of file. It can be up to three characters 
in length and separated from the filename by a period. Some application software will automatically 
give a file extension. For example, a document created by using Microsoft Word usually has a .doc 
extension. Naming a folder is the same as a file though a folder generally has no extension. The 
same restriction regarding characters also applies to filename extensions.
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Revision Exercises 

a) List down 5 ways to start Windows Explorer. 
b) Using Windows Explorer is a quick way to view, copy and move all files and folders between 

drives and folders because it provides a ___________(tree- like) structure. 
c) The ___________pane in Windows Explorer displays drives and folders in a tree-like structure. 
d) The ___________ side displays the contents of the current folder. 
e) Dragging a file to a destination in the same drive automatically _________the file.
f) Dragging a file to a destination in another drive automatically _________the file. 

Practical Exercises 

a) Create a WordPad file named Input in My Documents folder which contains the following text 
lines: Input Devices: 

Keyboard, Mouse, Joysticks, Touch screens, Scanners 
b) Create another Word Pad file named Monitor in the same location which contains the following 

text lines: Monitors: 
Cathode-ray Tubes, Flat Panel Monitors 

c) On a floppy disk, create two folders named Input and Output. 
d) Copy the Input file to the Input folder. 
e) Move the Monitor file to the Output folder. 
f) Rename the Monitor file in the floppy disk to Output. 
g) Open the Output folder. 
h) Print the screen by pressing the Print Screen key on your keybQoard and then paste the C image 

in MS Paint program. Save on your floppy disk as' Exercise_2h.jpg. 
i) Delete the Input file from My Documents.
j) Close Windows Explorer.  
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